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TO INSTALL CLOUDINGO STUDIO

1. Download the Cloudingo Studio installer and click the Run button to begin the initial installation process.

W Do you want to run this file?

Name: C\setup.exe

Publisher: Symphonic Source, Inc.
Type: Application
From: C:\setup.exe

Run Cancel

[V] Always ask before opening this file

While files from the Intemet can be useful, this file type can
potentially ham your computer. Only run software from publishers
you trust. What's the risk?

2. Cloudingo Studio will download the installation package. Click Install to complete installation.

Name:
loudingoStudi:

From (Hover over the string below to see the full domain):
studio.cloudingo.com

Publisher:
Symphonic Source, Inc.

[ mnstar | ) Dontinstall |

While applications from the Internet can be useful, they can potentially harm your computer. If
you do not trust the source, do not install this software. More Information...

3. The installation process may take a few minutes to complete.

(56%) Installing Cloudingo

This may take several minutes. You can use your computer to do other tasks
during the installation.

gag Name: CloudingoStudio
From: studio.cloudingo.com

E— —)

Downloading: 20.9 MB of 37.1 MB
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REGISTERING CLOUDINGO STUDIO

After the installation has completed you will need to register Cloudingo Studio to get a license. A registration
menu will appear after installation. (If it does not appear, try pressing Alt-Tab on your keyboard to see it, or
minimize windows until you see it).

1. Enter your registration details, select | Agree, and click Register. After registering you will receive an email with
a new license key.

2. Enteryour license key in the designated cell.

3. Accept to the license agreement, and click Validate License.

|

Cloudingo Studio Registration

Get your FREE license key by filling in the form below.

This is how the C team support/er requests.

First Name:

e, Last Name:
License Key: 1LK57SBWVXTOIDVaIidate License

Email Address:

1 agree to end user license agreement

Company:

D Iagree to end user license agreement

Register

Cancel

4. You are now ready to connect to Salesforce.
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CONNECT TO SALESFORCE (BASIC USE)

1. Launch Cloudingo Studio
2. Open the File menu and select Connect to Salesforce as shown below:

File| Edit View Options
< Connect to Salesforce

X&  Disconnect from Salesforce

New

B

Open
Open Recent
Close

Close All

Save
Save As
Save All

T EE EBE

Exit

Enter your Salesforce credentials in the popup dialogue box.
Click Connect and start using Cloudingo Studio for your Force.com development!

P w

File Edit View Options Window Help
O B NewQuey @ W 1A X
i Active v SOQL+ - 0 X = e

g3l Object Explorer v Q
@

\\ )
cloudingosfii

Connection Type Production v
Username/Email  johnsmith@johnsmith.com v
passwo'd FEXEEEEEES

Security Token 32Ikjf02mlma9082nli59023nj‘
Save Details?
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FEATURES (BASIC USE)
QUERY BUILDER

By clicking on one of the Orgs, Cloudingo Studio will automatically create a new query based on selected fields.
Uncheck or check different fields to alter the query on-the-fly:

File Edit View Options Window Help
¥ X§ B New Query W A%
i Active ryan.howard@95demo.com ~ SOQL+ 2R R R

i3 Object Explorer MRl | s0QLo.soq
£ I

4 ryanhoward@95demo.com 1 SELECT Id, MasterRecordld, Type, Parentld, BillingStreet, BillingCity, BillingState, B
4 Account

Id
IsDeleted
MasterRecordld
Name
Type
Parentld
BillingStreet
BillingCity
BillingState
BillingPostalCode
BillingCountry
ShippingStreet
ShippingCity

Or right-click an account org and generate a new query. There is a 1000 row limit based on selected fields:

WXE BNewQuey @ AA W
Active ryan.howard@95demo.com ~ SOQL+ Al A=K -
] Obect booe [
4 ryan.howard@95demo.com 1 SELECT Id, MasterRecordId, Type, ParentId, BillingStreet, BillingCity, BillingState, BillingPostalCode, Billil
4 [¥]Account
Query 1000 Rows l
[[]1sDeleted
MasterRecordld
[T Name
¥ Type
[¥] Parentld
BillingStreet
[¥] BillingCity
BillingState
BillingPostalCode
BillingCountry

Once you have created the query, execute it by clicking the green arrow button in the task bar, or pushing F5 on your
keyboard. The results will display in a grid just below your query (ies). You'll notice that every query generated includes
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a semicolon at the end. The semicolon is a Cloudingo Studio requirement for queries that are more than one statement
long. This requirement helps our parsing engine better understand which queries you want to run individually:

HH BNewQuey @ W OA¥

iActive ryanhoward@95demo.com ¥ SOQL= * P Run %9 % 3 ==
3
- Object Explorer S0QL0=0a”
4 ryanhoward@95demo.com 1 SELECT Id, IsDeleted, MasterRecordld, Name, Type, ParentId, BillingStreet, BillingCity, BillingState, BillingPostalCode, BillingCountry, ShippingStreet, Shipping
4 [ Account ShippingPostalCode, ShippingCountry, Phone, Fax, Website, Industry, ZnnualRevenue, NumberOfEmployees, Description, OwnerId, CreatedDate, CreatedById, LastModifie
& SystemModstamp, LastActivityDate, Jigsaw, JigsawCompanyld, AccountSource, SicDesc FRCM Account LIMIT 1000;
[¥l1d

[ 1sDeleted
MasterRecordld
Name

& Type

Parentld
BillingStreat
BillingCity
BillingState
BillingPostalCade
BillingCountry
[¥] ShippingStreet

[ ShippingCity

[ ShippingState

[ ShippingPostalCode
[ ShippingCountry

[ Phone

[¥] Fax

B Drag a column header and drop it here to group by that columin

[ industry #|1d | LsDeleted T |MasterRecordld ¥|Name ¥ |Type 7 |Parentid T | BillingStreet 7 | BillingCity ¥ | BillingState ¥ | BilingPostalCode ¥ | BillingCountry ¥ | ShippingStreet
[¥] AnnualRevenue b1 DO1GOOOOOOrSOZSIAI false TestName Edit From Grid!!

N“’“be'o'““p‘ﬂ?m 2 001G000000QUBBIIAY false Acme Praspect 10 Main Rl NewYork  TX 3149 usa 10 Main Rd.

Once you have executed a new Salesforce query, you optionally export it in four different formats (Excel, CSV, HTML, or
Text) using the Export button located between the query window and grid results:

Fax Y |Industry ¥ |IsDeleted V| Jigsaw ¥

{212) 555-5555 Agriculture -
Media e

Excel
Cs5Y
HTMKL

Sdemo.com (00:00:00.36 | 8 of 8 rows) More lmn

Sometimes queries will be written that contain a parsing error that Salesforce cannot interpret. When that happens,
you’ll see errors displayed on the Messages tab in the grid results window as shown below. This will give you a general
idea of what the problem is:
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50QL+ v| P Run 2% 3 =%

n plelol Bl SOCL1.sogl®

| = SELECT Id, IsDeleted, MasterRecorfld, Name, Type, ParentId, BillingStreet, BillingCity, BillingState, BillingPostalCo
ShippingPostalCode, ShippingCountry, Phone, Fax, Website, Industry, AnnualBewvenue, NumberCfEmployees, Description, Ow
SystemModstamp, LasthctivityDate, Jigsaw, JigsawCompanyId, AccountScurce, SicDesc FROM Account LIMIT 1000;

3 SELECT Id, IsDeleted, MasterRecordId, RccountId, LastName, FirstWName, Salutation, Hame, OtherStreet, Otherlity, Other
MailingPostalCode, MailingCountry, Phone, Fax, MobilePhone, HomePhone, OtherPhene, RhszistantPhone, ReportasTold, Email
OwnerlId, CreatedDate, CreatedById, LastModifiedDate, LastModifiedById, SystemModstamp, LastActivityDate, LastCUReques
JigsawContactId FROM Contact LIMIT 1000;

Messages

Error running Query: INVALID_FIELD:

SELECT Id, IsDeleted, MasterRecorfld, Name, Type, Parentld
-

ERROR at Row:1:.Column:23
No such column ‘MasterRecorfld’ on entity 'Account’. If you are attempting to use a custom field, be sure to append the *__c' after the custom field name. Please reference your WS

A useful feature you will find built into Cloudingo Studio is the ability to edit org data directly from your grid results. To
edit grid data, simply double-click on a data cell in your grid and enter a new value. Once complete, simply click away
from that cell’s row and your data will be automatically saved to your org:

3 ZELECT Id, IsDeleted, MasterRecordId, Zccountld, LastName, FirstWame, Salutation, Name, OtherStreet,
MailingPastalCode, MailingCountry, Phone, Fax, MobhilePhone, HomePhone, OtherPhone, AssistantPhone, Re
OwnerlId, CreatedDate, CreatedById, LastModifiedDate, LastModifiedById, SvstemModstamp, LastActivityDa
JigsawContactId FROM Contact LIMIT 1000;

Id T |IsDeleted ¥ | MasterRecordld T | Name T|Type T |Parentld T | BillingStreet
1 001G000000rS0ZEIAL  false TestName Edit From Grid!!
2 001G000000quBbIIAU  false Acme Prospect 10 Main Rd. New e
3 001G000000quBbKIAU false salesforce.com Customer The Landmark @ Cne Market, Suite 300 San Fre
4 001G000000quBbLIAU false Global Media  Prospect 150 Chestnut Street Toront
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SOQL+ (ADVANCED FEATURES)

Cloudingo Studio has been outfitted with a new extension of Salesforce’s SOQL query language, named SOQL+. With
SOQL+, the team at Symphonic Source added slick new enhancements to enable faster and more powerful queries
against your Salesforce Org. Just ensure your query language setting is set to SOQL+ in the language selector, and
you're good to go:

'? X? ‘8 New Query ﬁ] =] U’l a -X:

i Active ryan.howard@95demo.com ~ SOQL+ 2 K -
gJ Object Explorer SoQL+ !
i

4 ryan.howard@95demo.com SoQL SHLEC ™™g FROM

» [¥] Account

» [[] AccountContactRole
» [[]AccountFeed

» [C] AccountHistory

» [C] AccountPartner

» [[]AccountShare

» [C] ActivityHistory

» [C] AdditionalNumber
» [[]AggregateResult

» [[]ApexClass

» [C]ApexComponent
» [C]ApexLog

» []ApexPage

N P x

Some of the SOQL+ features include:

ENHANCED INTELLISENSE

Whether you’re creating a unique SOQL+ query or just a basic select, Intellisense will assist you in creating the query
faster than ever by displaying the available objects to query from and the functions you can perform on them:

SOQLO.sogl*

1 SELECT * FROM
f Account = | ItemDescription
5 AccountContactRole =
% AccountFeed

% AccountHistory

% AccountPartner

5 AccountShare

% ActivityHistory

" AdditionalNumber

" AggregateResult

"} ApexClass -
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SELECT ALL QUERIES

By typing in “SELECT * FROM Account”, or “SELECT * FROM” any org, you can automatically pull back all the fields
associated with that org without having to type them all out one-by-one!

INSERT, UPDATE, AND DELETE STATEMENTS

We’ve created a sweet translation engine that allows you to run SQL type queries in the Cloudingo Studio editor.
Cloudingo Studio converts them into API calls so whether you just want to do a quick update or clear out records by a
specific field type, Cloudingo Studio has you covered. Here are a few examples:

Use an UPDATE statement to change the name field on an account in your org. Update statements should, when
referencing fields, surround the values with single quotes as shown below:

UPDATE Account SET Name = 'Updated Names' WHERE Id ='001G000000r50nhIAA";

A standard INSERT statement follows the same general rule when referencing field values. The breakdown for an insert
statement is shown with an example below:

INSERT INTO Account (Name) VALUES (‘New Account Field");

Below is a standard DELETE statement where Cloudingo Studio removes one of the account records from the
connected org. Field references using single quotes still apply:
DELETE FROM Account WHERE Name = 'New Account Field";

LOOPING, AND VARIABLES:

Along with SOQL+, we've also added in some custom looping, and variable functionality. You can now create custom
variables, assign variables to other variables (Scope is also taken into consideration. A variable created within a ‘while’
loop has higher priority than one created in the general query statement), and increment/decrement variables using
the *+=" or ‘-=’ statements:

The following example will create a new grid query result on each loop iteration, and will continue to loop while varl
is less than var2, and is incremented on each loop by adding the value of var3 to varl:

var varl =1;
var var2 = 10;
var var3 = 1;

while(varl < var2)

{
SELECT * FROM Account LIMIT 1000;

varl += var3;

}
‘while’ loops can have up to 6 different types of value comparisons:

Note equal: !=
Greater than or equal to: >=
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Less than or equal to: <=
Equal to: =

Greater than: >

Less than: <

All changes using SOQL+ statements will show results in the “Messages” tab on the results pane:

SO0QL+ = p Run 9 % 3= =%

1]
- SOQLO.soql* gEelell BT iy
1 UPDATE Account SET Name = 'Updated Name' WHERE Hame = 'TestName';

Messages

Update Successful: UPDATE Account SET Name = 'Updated Mame” WHERE Name = 'TestName'
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ROW COUNT USING SELECT COUNT

We've also created a way to get the number of rows on a specified org by simply typing “SELECT COUNT() FROM
SomeOryg;”. After executing that query you’ll see the results in the Messages area on the results pane:

SOQL+ | p Run % % = ==

- I:‘I
SOQLO.soql* EEsle]REST i

1| SELECT COUNT() FROM Account;

Messages

4 rows found

SAVING/OPENING SOQL QUERY FILES (ADVANCED USE)

Cloudingo Studio provides you a way to save and open previous SOQL/SOQL+ files directly to your file system. Once
ready to save a new query, simply go to the File menu, and click Save:

File| Edit View Options Window Help

*¥  Connect to Salesforce aa¥

X#& Disconnect from Salesforce m ~ SOQL+ M R R

New SOQL4.soql™

1 SELECT COUNT () FROM Account;

B ow

Open
Open Recent
Close

Close All

Save
Save As

SEE EBEKE

Save All

Exit
» |C]ApexClass
» [[] ApexComponent
» [C]Apexlog
» [[]ApexPage
» [] ApexTestQueueltem

»_[[] ApexTestResult
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A save dialog popup will appear allowing you to specify the file. Once saved, the tab will be renamed and the asterisk
will disappear:

File Edit View Options Window Help
PWXE B NewQuey @M Ol A ¥

i Active ryan.howard@95demo.com ~ SOQL+ M R R

E Obiject Explorer MR | | NewsavedQuerysoql

4 ryan.howard@95demo.com 1 SELECT COUNT() FROM Account;
» [¥] Account
AccountContactRole
AccountFeed
AccountHistory
[] AccountPartner
AccountShare
ActivityHistory
AdditionalNumber
AggregateResult
ApexClass
ApexComponent

¥ ¥V ¥V ¥V ¥V ¥V v VvV Vv v

To open a SOQL/SOQL+ file you have previously saved, simply go back to the File menu, and select “Open”:

File| Edit View Options Window Help

*¥  Connect to Salesforce oAy

X#  Disconnect from Salesforce m v SOQL+ - 0 X 3= ==

v Q

‘B New
W@l Open
Open Recent ’

& Close

Exit
» || ApexClass
» [C]ApexComponent

An open file dialog will appear. Simply navigate to the file you want to open, select it, and click the Open button on the
dialog box. The saved query will open in a new tab.
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TROUBLESHOOTING
GETTING CLOUDINGO STUDIO’S VERSION NUMBER:

Sometimes you’ll need to obtain the current version number of your copy of Cloudingo Studio. To do this, simply go to
the Help menu, and select About. A popup box will appear displaying the version of Cloudingo Studio.

:mo.com NT () FROM Acd
Feature Request

Support Request
tactRole

g About...
ory
ner

re

pry

LOCATING CLOUDINGO STUDIO ERROR LOG

By default, Cloudingo Studio writes an error log in its working directory. To access this log, do the following:

1) Start-up Cloudingo Studio.

2) Right-click on your windows task bar and select Start Task Manager, select the Applications tab, and find
Cloudingo Studio in the list of running applications.

3) Right-click on Cloudingo Studio in the list of applications, and select Go to Process.

4) Inthe list of processes you’ll see the Cloudingo Studio process. Right-click that process and select Open file
location.

5) The location of the running application will pop-open. Inside that folder you’ll find the Cloudingo Studio log,
labeled “CloudingoStudio.log”.
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